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StudentTracker Detail Report  
Excel Guide 

Every StudentTracker report includes a “Detail Report” that contains available student-by-

student term-by-term college enrollment information. 

How the National Student Clearinghouse populates its database 
More than 3,300 of US colleges and universities participate with the Clearinghouse.  

 The Clearinghouse receives enrollment information from its participating colleges and 

universities several times throughout a term. 

For each term: 

o The schools must report information within 30 days of the start of the term. 

o The schools then update information throughout the term (every 30-45 days). 

o The schools must submit their last enrollment report of the term no later than 2 

weeks after classes end.  

 

For a list of participating colleges and universities, go to: 

http://www.studentclearinghouse.org/colleges/coreserv/docs/CoreParticipants.xls 

 

 The Clearinghouse receives degree information from colleges and universities 

participating in DegreeVerify. Schools typically submit a degree file after each conferral 

period, once the majority of degrees have been posted. They may submit an additional 

degree file when additional degrees are posted. 

For a list of colleges and universities participating in DegreeVerify, go to: 

http://www.studentclearinghouse.org/secure_area/DegreeVerify/dv_ParticipatingSchools

.asp 

FERPA (Family Educational Rights and Privacy Act) 
The Family Educational Rights and Privacy Act is a federal law that protects student’s privacy 

rights in their education records. Since our inception in 1993, the Clearinghouse has maintained 

the confidentiality and privacy of more than 100 million student records in full compliance with 

FERPA regulations. StudentTracker releases only unrestricted directory information (e.g., 

school names and dates of attendance) from records received from a student's other post-

secondary institutions, unless FERPA authorizes disclosure without consent. 

http://www.studentclearinghouse.org/colleges/coreserv/docs/CoreParticipants.xls
http://www.studentclearinghouse.org/secure_area/DegreeVerify/dv_ParticipatingSchools.asp
http://www.studentclearinghouse.org/secure_area/DegreeVerify/dv_ParticipatingSchools.asp
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Understanding the Detail Report  

Data elements 

1. Your Unique Identifier 

Max. Length = 16 

Column A  

The Student ID number as provided in the diploma file (column J) or in the request file 

(column L). In order to preserve number formatting, each ID ends in an underscore, e.g., 

101220_. 

 

2. First Name 

Max. Length = 20 

Column B 

Student's first name as provided in the diploma or request file (column C). 

 

3. Middle Initial 

Max. Length = 1 

Column C  

Student's middle initial as truncated from the middle name provided in the diploma or 

request file (column D). 

 

4. Last Name 

Max. Length = 20 

Column D  

Student's last name as provided in the diploma or request file (column E). 

 

5. Name Suffix 

Max. Length = 5 

Column E  

Student's name suffix as provided in the diploma or request file (column F). 

 

6. Requester Return Field 

Max. Length = 50 

Column F 

Diploma process: 

The Social Security number as provided in the diploma file (column B). In order to preserve 

number formatting, each SSN ends in an underscore (e.g., 123456789_).  

Request process: 

Data provided by requester in the Requestor Return Field (column K) of the request. 

Returned unaltered to help requester process the detail report (e.g. cohort identification, 

unique student ID, etc.). In order to preserve number formatting, each field ends in an 

underscore (e.g., 123456_) If no data was provided, the field is blank. 

 



 

If you have questions or need assistance, contact Gillum@studentclearinghouse.org 
© 2010 National Student Clearinghouse All rights reserved 5 

 

7. Record Found Y/N 

Max. Length = 1 

Column G  

Y = Detail report contains student's college record                               

N = Detail report does NOT contain student's college record 

 

8. High School Code 

Max. Length = 6 

Column H  

High school code of the high school from where the student graduated as provided in the 

diploma file (column O) or in the request file (column I). 

 

9. High School Grad Date 

Max. Length = 8 

Column I 

High School Grad date as provided in the diploma file (column L) or Last Date of Attendance 

as provided in the request file (column H). 

 

10. College Code/Branch 

Max. Length = 9  

Column J 

OPE/FICE code of the college that the student attended. 

 

11. College Name 

Max. Length = 40  

Column K 

Name of the college that the student attended. 

 

12. College State  

Max. Length = 2  

Column L 

State in which the college that the student attended is located. 

 

13. 2-Year/4-Year 

Max. Length = 1 

Column M 

Type of college that the student attended                                           

 4 = 4-year or higher institution                                                                  

 2 = 2-year institution                                                                                       

 L = Less than 2-year institution 
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14. Public/Private 

Max. Length = 7  

Column N 

Indicates whether the college that the student attended is a "Public" or Private" institution. 

 

15. Enrollment Begin 

Max. Length = 8  

Column O 

Begin date for the student’s period of attendance. 

 

16. Enrollment End 

Max. Length = 8  

Column P 

End date for the student's period of attendance. If the student withdraws during the term, the 

effective date of the withdrawal is the “enrollment end.” 

 

17. Enrollment Status 

Max. Length = 1 

Column Q 

The last enrollment status reported for the student:                      

 F = Full-time                                                                                                                  

 H = Half-time                                                                                                                  

 L = Less than half-time                                                                                        

 A = Leave of absence                                                                                        

 W = Withdrawn                                                                                                     

 D = Deceased                                                                                                

This field will be blank if the reporting college has not defined the student's enrollment status 

as directory information. 

 

18. Graduated? 

Max. Length = 1 

Column R 

Graduation status information available from the reporting college.                                                                                                                    

 Y = College reported the students as graduated 

 N = College did NOT report the student as graduated 

 

19. Graduation Date 

Max. Length = 8  

Column S 

Date of student's graduation or degree achievement as provided by the reporting college. 

 

 

 



 

If you have questions or need assistance, contact Gillum@studentclearinghouse.org 
© 2010 National Student Clearinghouse All rights reserved 7 

20. Degree Title 

Max. Length = 80  

Column T 

If available, the title of the degree the student received as provided by the reporting college. 

 

21. Major 

Max. Length = 80  

Column U 

If available, the major associated with the student's degree as provided by the reporting 

college. 

 

22. College Sequence 

Max. Length = 2  

Column V 

The sequential order of each school that the student attended. The first record from the first 

school that the student attended will have a "1" in this field, the first record from the second 

school that the student attended will have a "2" in this field, and so on. 

Inclusion of records 

If a student is found in our database, StudentTracker will check whether or not the student has 

requested a FERPA block. 

 If the student is blocked, detail-level information is not reported. 

 If the student is not blocked, StudentTracker reports any applicable enrollment records 

(one per term) and/or graduation records for this student based on the high school 

grad date. 

Sort Order 

The students are returned in the Detail Report sorted by “Your Unique Identifier” (column A) 

first.  If blank, the sort will proceed by “Last Name” (column D) in alphabetical order. 

 If the student is not found (or is blocked), the student appears only once. The row 

contains the student’s name and search date. Also, the “Record Found Y/N” field is 

populated with “N” for this row. 

 If the student is found, there is one row for each reported term this student was enrolled 

for. The “Record Found Y/N” field is populated with “Y” for each of these rows. All of the 

rows for a particular student are grouped by college attended. Within each group, the 

records are sorted by “Enrollment Begin” and each group is assigned a “College 

Sequence”1. Lastly, the groups are sorted by the “College Sequence” field from lowest to 

highest. 

                                                           
1
 The “College Sequence” is assigned based on the “Enrollment Begin” date. That is, the group of records that has 

the earliest (or latest depending on query type) “Enrollment Begin” date is assigned a “College Sequence” of “1”. 
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Using Excel to extract information from the Detail Report 

Task 1: Remove duplicates 

You can use Excel to extract the first row of each student that appears in the Detail Report.  

To do this: 

1. Open the Detail Report in Excel. 

Note: You should save a copy of the Detail Report to another worksheet or workbook 

before removing duplicate values.  

 

2. Select all cells on the worksheet.  

 

To select all cells on a worksheet, do one of the following: 

a. Click the Select All button.  

 
 

b. Press CTRL+A.  

 

3. On the Data tab, in the Data Tools group, click Remove Duplicates.  

 

4. Click Unselect All.  

 

5. If unchecked, check the box My data has headers. 

 

6. Under Columns, select one or more columns depending on how unique your data is. 

a. If you have used a High School Student ID, select Your Unique Identifier. 

 

b. If you have used SSNs, select Requester Return Field. 

 

c. If you do not have any unique field, you should select a combination of fields. An 

good way to do this is to select the all the columns from Your Unique Identifier 

to High School Grad Dt. 
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Tip: To make the Remove Duplicates window wider or longer, click and drag the 

grip handle at the bottom. 

 

7. Click OK.  

A message is displayed indicating how many duplicate values were removed and how 

many unique values remain, or if no duplicate values were removed. 

 

8. Click OK. 

 

Once you complete step 8, you will have one row per student. The question you can ask 

yourself is whether the row you obtained is useful to your research.  

If the answer is “no”, you can go back and restart the process.  

When you use the Remove Duplicates button, the row that is conserved is whatever row is 

found first, from top to bottom. Therefore, to obtain different results, you can first sort the data in 

a manner that suits your needs. Once you have re-sorted the data, you can then remove the 

duplicates. 
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Task 2: Sort the data 

There are many ways you can sort the data in the Detail Report.  

 By the earliest (or latest) “Enrollment Begin” date 

 By the earliest (or latest) “Enrollment End” date 

 By “Record Found Y/N” 

 By “College Sequence” from lowest-to-highest or from highest-to-lowest. 

 By “Graduated?” 

 By a combination of these 

This task shows an example of how to sort each student’s data by the “Enrollment End” date: 

1. Open the Detail Report in Excel. 

Note: You should save a copy of the Detail Report to another worksheet or workbook 

before sorting the data.  

 

2. Select all cells on the worksheet.  

 

To select all cells on a worksheet, do one of the following: 

a. Click the Select All button.  

 
 

b. Press CTRL+A.  

 

3. On the Data tab, in the Sort & Filter group, click Sort.  

 
 

4. The Sort dialog box is displayed.  
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5. If unchecked, check the box My data has headers. 

 

6. Under Column, in the Sort by box, select the first column that you want to sort. For this 

example, select the “Last Name” field first. 

a. Under Sort On, select Values.  

b. Under Order, select how you want to sort. Do one of the following:  

i. For text values, select A to Z or Z to A.  

ii. For number values, select Smallest to Largest or Largest to Smallest.  

 

 

7. To add another column to sort by, click Add Level, and then repeat steps 3 through 5. 

Add the columns: “First Name,” “Middle Initial,” “High School Grad Dt,” and “Enrollment 

End.” 

 
8. Click OK 

Once you complete step 8, you will have sorted the records for each student by the “Enrollment 

End” field. 

Entries higher in the list are sorted before entries lower in the list.  

The first 4 levels (Last Name, First Name, Middle Initial, and Search Date) were used to make 

sure that all records for the same student are grouped together. If unique identifiers are 

available, those columns can be used in addition to or instead of the fields used above. 
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The last level (Enrollment End) was used to sort each student’s records. So that, for each 

student, the top record is now the record with the earliest “Enrollment End” date and the bottom 

record is now the record with the latest “Enrollment End” date. 

If you remove the duplicates at this time, the row you obtain from each student is the following: 

The earliest term (based on the earliest “Enrollment End” date) that this student attended out of 

all the terms reported for this student in the Detail Report. 

 

Task 3: Filter the data 

Filtering the data is a great way to summarize the information. You may filter the complete 

dataset or you may filter the unduplicated dataset depending on your needs. 

To filter the data: 

1. Open the Detail Report in Excel. 

Note: In this case, you do not need to save a copy because filtering does not change or 

delete the data.  

 

2. Select all cells on the worksheet.  

 

To select all cells on a worksheet, do one of the following: 

 Click the Select All button.  

 
 

 Press CTRL+A.  

 

3. On the Data tab, in the Sort & Filter group, click Filter.  

 

 
 

4. Click the arrow in the column header. For this example click the arrow in column G, 

the “Record Found Y/N” field.  

 

5. In the list of values, select or clear one or more values to filter by.  

 The list of values can be up to 10,000. If the list is large, clear (Select All) at the 

top, and then select the specific text values to filter by.  
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 For this example, clear the value “N” 

 

Tip: To make the AutoFilter menu wider or longer, click and drag the grip handle at 

the bottom. 

 

6. Click OK 

 

7. You may also apply additional filters. For this example, you will now filter the data to 

capture enrollment records during a particular term.  

 

8. Click the arrow in the “Enrollment End” field. This time you will use “Number Filters” 

instead of making selections. To do this: 

 Point to Number Filters and then click one of the comparison operator 

commands. For this example, select Less Than or Equal To… 

 In the Custom AutoFilter dialog box, in the box or boxes on the right, enter 

numbers or select numbers from the list. For this example, enter: 20051231 

 
 Click OK 

 

 

javascript:AppendPopup(this,'xldefComparisonOperator_3_3')
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9. To avoid capturing data for a previous term, you will filter by the “Enrollment Begin” field 

as well. To do this: 

 Point to Number Filters and then click one of the comparison operator 

commands. For this example, select Greater Than or Equal To… 

 In the Custom AutoFilter dialog box, in the box or boxes on the right, enter 

numbers or select numbers from the list. For this example, enter: 20050801 

 Click OK 

 

Once you complete step 9, you will capture all the records available for the fall of 2005.  

 

If a student was enrolled in two places, you will see two rows for that student. If you have 

duplicates for each student and would like to remove them, you will have to copy the resulting 

rows to a separate worksheet and perform the task “Remove Duplicates”  

 

Hint: To clear all filters in a worksheet and redisplay all rows: 

 On the Data tab, in the Sort & Filter group, click Clear.  

 

 

Task 4: Split a date field into year, month, date. 

The Detail Report contains three date columns: the search date/high school grad date, the 

enrollment begin date, and the enrollment end date. The format of these columns is a number, 

and hence you cannot filter these values dates. In the previous task, we took advantage of the 

“greater than” and “less than” operators to work with the dates as numbers. This task shows 

another way to handle these dates by splitting them into three columns: year, month, and date. 

1. Insert three columns to the right of each date column you would like to split. This is to 

prevent existing data in adjacent columns from being overwritten by the data that will be 

distributed.  

 

2. Select the entire column that contains the values that you want to split.  

 

3. On the Data tab, in the Data Tools group, click Text to Columns. 

 

javascript:AppendPopup(this,'xldefComparisonOperator_3_3')


 

If you have questions or need assistance, contact Gillum@studentclearinghouse.org 
© 2010 National Student Clearinghouse All rights reserved 15 

 

4. In Step 1 of the Convert Text to Columns Wizard, click Fixed Width, and then click 

Next.  

 

5. In the Data preview box, drag a line to indicate where you want the content to be 

divided.  

 
 

Tip: To delete a line, double-click it. 

 

6. Click Next.  

 

7. In Step 3, you can click a format option under Column data format. The default 

selection is General. For this example, the General format will be sufficient. 

 

8. Click the icon to the right of the Destination box, and then click the column next to 

the date column you are working on.  

IMPORTANT: If you do not specify a new destination for the new columns, the 

divided data will replace the original data. 
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9. Click the icon to the right of the Convert Text to Columns Wizard.  

 

10. Click Finish.  

 

Task 5: The Date function  

Now that you have split the dates into year, month, and day, you may want to re-join them. The 

DATE function can do this and will format the result as a date. The DATE function syntax is: 

DATE(year, month, day) 

A2 B2 C2 

2008 1 1 

Formula Description Result 

=DATE(A2,B2,C2) Serial date for the date derived 
by using cells A2, B2, and C2 as 
the arguments for the function, 
and using the 1900 date system. 

1/1/2008 or 39448 

 

 

Task 6: COUNTIF and COUNTIFS functions 

The COUNTIF function syntax is: 

COUNTIF(range, criteria) 

range  Required. One or more cells to count, including numbers or names, arrays, or references that contain 

numbers. Blank and text values are ignored.  

criteria  Required. A number, expression, cell reference, or text string that defines which cells will be counted. For 

example, criteria can be expressed as 32, ">32", B4, "apples", or "32". 

Formula Description Result 

=COUNTIF(V:V, 2) 
Number of cells with a "2" in the College 
Sequence field 12 

=COUNTIF(V:V, 3) 
Number of cells with a "3" in the College 
Sequence field 2 

=COUNTIF(V:V, ">1") 
Number of cells with a value larger than 1 
in the College Sequence field 14 
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The COUNTIFS function syntax is: 

COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2]…) 

criteria_range1  Required. The first range in which to evaluate the associated criteria.  

criteria1  Required. The criteria in the form of a number, expression, cell reference, or text that define which cells will 

be counted. For example, criteria can be expressed as 32, ">32", B4, "apples", or "32".  

criteria_range2, criteria2, ...  Optional. Additional ranges and their associated criteria. Up to 127 range/criteria pairs 

are allowed.  

Formula Description Result 

=COUNTIFS(I:I,20050801,N:N
,"Private") 

Number of records with hs grad date 20050801 
where the college of attendance is “Private” 52 

 

 

Task 7: Using PivotTables 

PivotTables allow you to see and explore the data. For this example, you will count the number 

of unique students who went to each of the colleges reported.  

1. Before you start with this task, you will need to use the Remove Duplicates button. 

When doing this, select all columns from Your Unique Identifier to College 

Code/Branch in the Remove Duplicates window. As a result, for each student, this will 

remove duplicate terms for each college attended.  

 Remember to save a copy of the report before you remove the duplicates. 

 

2. Once you have removed the duplicates, select all cells on the worksheet.  

To select all cells on a worksheet, do one of the following: 

 Click the Select All button.  

 
 

 Press CTRL+A.  

 

3. Select the type of report to generate by doing the following:  

To create a PivotTable report: 

 On the Insert tab, in the Tables group, click PivotTable, and then click 

PivotTable.  

 



 

If you have questions or need assistance, contact Gillum@studentclearinghouse.org 
© 2010 National Student Clearinghouse All rights reserved 18 

 Excel displays the Create PivotTable dialog box. 

 

4. Since you selected a range of cells before you started the wizard, Excel displays the 

range of cells or table name reference in the Table/Range box. 

 

5. Specify a location by doing one of the following:  

 To place the PivotTable report in a new worksheet starting at cell A1, click New 

Worksheet.  

 To place the PivotTable report in an existing worksheet, select Existing 

Worksheet, and then specify the first cell in the range of cells where you want to 

position the PivotTable report.  

 

6. Click OK.  

 Excel adds an empty PivotTable report to the specified location and displays the 

PivotTable Field List so that you can add fields, create a layout, and customize 

the PivotTable report.  

 

7. Under Choose fields to add to report, move one or more fields to the Row Labels 

area.  

 If you have used a High School Student ID, select Your Unique Identifier and 

drag to the Row Labels area. 

 

 If you have used SSNs, select Requester Return Field and drag to the Row 

Labels area. 

 

 If you do not have any unique field, you should select a combination of fields, 

such as Last Name and First Name. To do this, select one of the fields and drag 

to the Row Labels area and repeat for the next field.  

 

8. Under Choose fields to add to report, move one or more fields to the Column Labels 

area.  

 For this example, you will select 2-year / 4-year and College Name drag them to 

the Column Labels area. 

 

9. Under Choose fields to add to report, move one or more fields to the Values area.  

 For this example, you will select College Name and drag to the Values area. 

 Excel will automatically select a summary function. In this case, the selected 

function is COUNT. You can change the summary function, but this is not 

necessary at this time. 

Once you complete step 9, you will have a table summarizing the number of students that 

attended each of the colleges reported. 


